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Preface
This manual will guide you through three practicals in which you will assemble and annotate a whole genome. Genome assembly and annotation
is but a small part of the whole genomics research area, but it is crucial
that you familiarize yourself with these concepts and techniques as they are
the starting point in any genome sequencing project. Due to time restrictions and computer limitations you will work with bacterial genomes, but
the same principles are used in larger genome projects: sequencing, quality
check, assembly, annotation and comparison with other genomes.
These practicals are part of the BS982 - Genomics module at the University
of Essex but I tried to write with enough detail so anyone can use it. It is
distributed under the Creative Commons license so you are free to use it,
modify it and distribute it.
This guide as well as datasets and other materials are available in the teaching
section at http://amarco.net/. The original datasets are available from
public repositories. When preparing this practical I had to modify some
data and create alternative labels so they all fit into the story.
I am grateful to Igor Chernukhin for setting up the Galaxy server in the
School of Biological Sciences, and my students of BS982 for their comments
and feedback. For any suggestion or question write me at amarco.bio@gmail.com.
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Practical 1
De novo assembly of genome
sequences
When we plan to sequence a genome, the first step is isolating DNA from
the species of interest, and then (after processing) sequence our DNA sample
in a sequencing machine. However, it is not possible to sequence an entire
genome or chromosome from the first nucleotide to the last in a row. Indeed,
it is not possible to sequence more than a few hundred nucleotides in a
single sequencing reaction1 and, most often, sequencing machines produce
reads as short as 50 to 100 nucleotides. The reasons for such limitations
were discussed during the main lectures. Genome assembly is the process by
which a full genome sequence is reconstructed from shorter sequences. This
practical covers genome assembly following a fictional story. During the class
you will be given instructions to download the programs and datasets you
need for this practical.
In this session we are going to assemble a bacterial genome using state-of-theart computational tools. This process is usually done in a UNIX environment
but during this practical we will use Microsoft Windows versions of the programs.

1

Although new technologies based on single molecule sequencing are getting pretty
close. Chances are that we will be able to sequence small genomes in a single read very
soon.
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Figure 1.1: Overview of this practical

1.1

Sequencing machines and read quality

Outbreak alert! Hundreds of people in your area have been hospitalized with
severe abdominal pain and diarrhea. Fortunately, the likely cause of these
symptoms have been detected: contaminated apricots. The microbiologists
have identified and isolated a bacteria from the skin of these fruits. As the
research in this bacteria continues, a second outbreak in a different neighborhood kills 3 people. Within a month, almost a million cases have been
reported around the globe, and the disease seems unstoppable. In a collaborative effort, several universities have isolated and sequenced the DNA of
these bacteria, and you are part of the team that will analyze some of these
sequences. For your first task, you are given DNA sequences from a sequencing machine, and you must assemble them into a genomic sequence that may
help to identify the nature of the pathogen.

1.2

Assembly of short reads into contigs

The sequencing department have provide you with about 2 million sequencing
reads, with single-end ends, from a Illumina Genome Analyzer IIx sequencing
machine. Also, from electrophoretic analysis, you estimated that the genome
size is approximately 2 megabases. You should first download the data and
programs from a zip file provided by your instructor (available from Moodle)
and unzip it into the C:\temp\ folder (ask someone if you’re not familiar
with the folder structure of a PC). Keep the C:\temp\genomics folder open
throughout the practical. The first step is to take a look at the data and
check the quality of the reads. For that, you will make use of fastqc, a
visual program that analyze reads from sequencing reactions.
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Task 1: Reads quality assessment
1. Open the fastqc program (double-click on run fastqc in the FastQC
folder).
2. From the menu, select File/Open and select the FASTQ file with the sequencing reads (provided by the facilitator, also in the C:\temp\genomics
folder).
3. The reads will be then analyzed (that will take a couple of minutes).
4. Navigate the different tabs and collect the relevant information.
5. Save the report (File ->Save report...) and keep it for your own record.
Some graphs may be included in your final report.

Questions to be addressed in the final report
• How many reads are in the file?
• What is the length of the reads?
• How was the quality of the reads overall?
• How was the quality of the reads for each base position?

High-duplication levels do not affect to the quality of the assembly, but they
have an impact in the speed of the process. In this practical we will not take
this into account.
Next step is to merge overlapping reads into contigs. There are many ways of
doing so, but one of the most popular is the use of De Bruijn graphs. These
were mentioned in the lectures. We will use a program called Velvet, which
is a very popular genome assembler. Velvet uses De Bruijn graphs and
works under UNIX enviroments. For this practical, a Windows compilation
was kindly provided by Applied Maths (http://www.applied-maths.com).
Velvet requires a number of parameters, the choice of which will affect the
output. There are computer programs that systematically explore the effect
of different parameters to determine the appropriate choice of values (e.g.
VelvetOptimizer). A critical parameter is the hash length (k ). The hash
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length defines how the De Bruijn graphs are constructed. In this practical
we will use the web-based program Velvet Advisor at Monash University
to estimate the optimum value of k.
The FASTQ file format
FASTQ format is a text-based format for storing both a biological sequence
(usually nucleotide sequence) and its corresponding quality scores. Both the
sequence letter and quality score are encoded with a single ASCII character for
brevity. It was originally developed at the Wellcome Trust Sanger Institute to
bundle a FASTA sequence and its quality data, but has recently become the de
facto standard for storing the output of high throughput sequencing instruments
such as the Illumina Genome Analyzer.
A FASTQ file normally uses four lines per sequence.
Line 1 begins with a ’@’ character and is followed by a sequence identifier
and an optional description (like a FASTA title line).
Line 2 is the raw sequence letters.
Line 3 begins with a ’+’ character and is optionally followed by the same
sequence identifier (and any description) again.
Line 4 encodes the quality values for the sequence in Line 2, and must
contain the same number of symbols as letters in the sequence.
A FASTQ file containing a single sequence might look like this:
@SEQ ID
GATTTGGGGTTCAAAGCAGTATCGATCAAATAGTAAATCCATTTGTTCAACTCACAGTTT
+
!’’*((((***+))%%%++)(%%%%).1***-+*’’))**55CCF>>>>>>CCCCCCC65
The character ! represents the lowest quality while ~ is the highest.
Source: http://en.wikipedia.org/wiki/FASTQ_format

Task 2: Assembly
1. Open a web browser and go to
http://dna.med.monash.edu.au/~torsten/velvet_advisor/
2. Fill in the Questions form: million reads (nearest integer), whether they
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are single- or paired-ends, the length of the reads, and the approximated
size of the genome.
3. Set fold k-mer coverage to 20.
4. Keep this page open, as it contains useful information for the next step.
5. Open a command line terminal (Execute cmd program).
6. Navigate into the working directory2 . That is, in the command-line
type cd C:\temp\genomics and press the RETURN key.
7. Velvet runs in two steps, and actually you should run two different
programs for each step: velveth and velvetg.
8. Run velveth assembler over the raw sequence reads from the command
line. The parameter K and the value of the SEQUENCE TYPE are provided
by Velvet Advisor (from the previous step). The tag -fastq indicate
the input file format. Replace INPUT FILE by the file name with the
sequence reads, and run the following command:
velveth.exe assembly K -fastq SEQUENCE TYPE INPUT FILE
This step will take some time (about 5-10 mins depending on the computer). This is a good time to update your notebook and check you
phone and/or email.
9. Run the program velvetg over the output folder, specifying the minimum length of the contig to 200 nucleotides:
velvetg.exe assembly -min contig lgth 200
10. After the process is done, the assembled contigs will be in the file
contigs.fa within the folder assembly, and some useful statistics will
be at Log file in the same folder. Open these files using the a text editor
such as notepad.

Questions to be addressed in the final report
• Which parameters and options did you use to assemble the reads?
• How many contigs did you assembled? (the number of contigs is the
number of nodes in the De Bruijn graph)
2

Further instructions will be given by the facilitator if you are not familiar with the
command-line.
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• What is the N50 of your assembly?

1.3

Combining contigs into scaffolds

Up to this point you will have a preliminary assembly of the genome. However, the many contigs produced are unsorted, and even the relative orientations will be unknown. Multiple contigs are sorted into scaffolds. To obtain
scaffolds, different strategies are used (as we covered in the lectures), such
as combining different sequencing technologies. When the genome is small,
and we know the genome sequence of a close relative, one way of ordering
contigs into scaffolds is to align the contigs to a closely related genome.
Based on what the microbiologists have told you, your bacteria is probably
a proteobactera of the genus Campylobacter. With this information at hand,
you decide to align your contigs to the reference genome of Campylobacter
coli, a bacteria found in human intestines, using the program Mauve, which
should be pre-installed in your computer.

Task 3: Align contigs to a reference genome
1. In a web-browser go to the genomes database at the European Bioinformatics Institute http://www.ebi.ac.uk/genomes/.
2. Navigate the Bacteria genomes (menu in the left) to find the genome
entries for Campylobacter coli.
3. In the Campylobacter coli 76339 isolate row, click on ’HG326877’ in
the 5th column (NOT in the 4th column). You will see the genome
information page.
4. Write down in your notebook the sequence length. Right-click in the
’Download: FASTA’ link and save the genome sequence file in the
working directory (C:\temp\genomics).
5. Open the program Mauve.
6. Select ’Tools/Move contigs’ option.
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7. Select C:\temp\genomics as the output folder. Ignore the warning
message.
8. A new window called ’Align and Reorder Contigs’ will appear.
9. Click on ’Add sequence’ and select the reference genome assembly
(HG326877.fasta).
10. Click on ’Add sequence’ and select yous contigs file (contigs.fa).
IMPORTANT. The sequences must be added in that order, first the
reference genome and then your contigs file.
11. Click ’Start’. Wait till the process is done.
12. You will see in a window how the iterative aligments progress. A series of folders sequentially named ’alignment1’, ’alignment2’, etc, will
appear in the main folder. Open the one with the largest number, as
it will have the best match.
13. Copy the file contigs.fa.fas from this folder into C:\temp\genomics
and rename it as assembly.fasta. This is you genome assembly file!
14. Open the file contigs.fa contigs.tab from the Mauve alignment folder
with Notepad or another text editor. You will find some useful information about the ordering process.

Questions to be addressed in the final report
• What is the size of the reference genome?
• How may contigs mapped to the reference genome?
• How many of them mapped with forward orientation?
• How many of them mapped with complement orientation?
• For how many contigs there were conflicting information?
If you want to keep any of the output files, you must copy them into a flash
drive. The M: folder may not be big enough. It is recommended that you
save the files you generated in the FastQC analysis, as well as Log (from your
Velvet assembly) and contigs.fa contigs (from the Mauve program) for
future reference when writing your report.
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1.4

Finishing up: closing gaps

The hardest and slowest part of any genome project is the finishing, or the
gap closure. Even if you increase dramatically the number of sequencing
reads, there will be still gaps in your assembly. How do we finish genome
assemblies? As you will remember from the lectures, reads from different
sequencing technologies are often combined to improve coverage. Finally,
the open gaps are usually completed by directly sequence by PCR or cloning
of the relevant regions, using information from the contigs ends. It will be
unrealistic to complete a genome project within the context of a practical
module, so we will just assume that the ’finishing genomes’ department will
do the job for you. In the next practical, you will analyze the assembled
genome to detect and annotate genes.

1.5

Further reading and advanced tools

The programs used in this practical are used in actual genome assembly
projects. However, they are run in a UNIX environment, which permits
the use of advance settings that optimize the genome assembly process. If
you want to know more about genome assembly I recommend the following
review articles:
• Schatz MC et al. (2010) Assembly of large genomes using secondgeneration sequencing. Genome Res 20:1165-1173.
• Nagarajan N and Pop M (2013) Sequence assembly demystified. Nat
Rev Genet 14:157-167.
A more advance text covering the finishing of genome assemblies can be found
in:
• Nagarajan N et al. (2010) Finishing genomes with limited resources:
lessons from an ensemble of microbial genomes. BMC Genomics 11:242.

Practical 2
Functional annotation of
genomes
From our previous exercise we came up with a fully assembled genome sequence of our unknown pathogenic bacteria. Now it’s time to know what all
these letters (A,C,G,T) mean. In this practical you will use different techniques to detect and annotate genes in your genome. Although the programs
here discussed are used in Bacteria annotation, the same principles apply to
the annotation of eukaryotic genomes.

2.1

Detecting and annotating genes

Well done! You and your team successfully sequenced and assembled the
genome of the bacteria that has been intimidating the world. But we still
don’t know much about this bacteria. For the moment you know is a Campylobacter -type species with a genome of about 2Mb in size. You, as the expert
genome scientist in your team, are in charge of making sense of the whole
genome sequence.
First, you need to predict genes in the genome sequence. As we discussed in
the lectures, in bacterial genomes it is relatively easy to detect protein-coding
genes. A number of web servers allow you to do this online, without running
any program in your computer. You will submit your sequence to BASys,
11
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which combine different tools to fully annotate a bacterial genome sequence.
These servers may be slow, and for that reason you will submit your genome
sequence but then you will explore the results already generated a few days
ago, so you don’t have to wait.

Task 1: Automatic annotation of bacterial genomes
1. Open a web browser and go to https://www.basys.ca/
2. Choose one of the servers.
3. Fill in the form including your email address.
4. The Genome identifier is a name you give for your own records (it can
be anything).
5. The bacteria is Gram Negative (as all other Campylobacter ).
6. The contig is circular.
7. Click on the ’browse’ tab and select the genome file provided by your
instructor (available from Moodle).
8. Click on ’submit’

Now, the annotation process may take a few days. You will receive an email
when the annotation is ready. However, instead of waiting for the results, we
have previously run an annotation process a week ago, and you can find the
results in the address provided by your instructor.

1. Open the annotation web page from Moodle.
2. Click on View Map. You may use this figure in your final report (save
it first).
3. Right-click on the ’Gene Fasta File’ and save it in your computer. This
file contains the genes predicted for your genome, and you will need it
in the next task.
4. If you click on ’Expand’ you will be able to look into the details of the
genome annotation.
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5. In ’View Table’ from the main menu you will find a list of predicted
genes with their annotation.
6. Click on the first gene: BASYS00001
7. You will find useful information on nucleotide and amino acid sequences, whether it is in an operon or not, and functional annotation
based on Gene Ontology.
8. Copy the nucleotide sequence and do a BLAST search against the NCBI
’non-redundant’ database. The first hit will tell you which species is
this.

Questions to be addressed in the final report
• How many genes did you annotate with BASys?
• Briefly describe the annotation of one of the genes of your choice.
• From which species is the bacterial sample?

2.2

Gene expression analysis

Now you have a series of genes annotated to your genome. How could you
make sure that they are expressed? Well, the only way is to measure gene expression. While you were sequencing and annotating this bacteria, colleagues
at another institution have extracted and sequenced the RNA content of some
bacterial samples. They have deposited this information in a public repository, and you only have to get this data and compare them with your genome
annotation. You will be using the full power of Galaxy, a web-based set of
programs for bioinformatic analysis.
You will be using the Galaxy server at the School of Biological Sciences,
which is only accessible within campus. There are two addresses to access to
it:

• http://bsproteomics/galaxy/

14

PRACTICAL 2. FUNCTIONAL ANNOTATION OF GENOMES

Figure 2.1: The School of Biological Sciences Galaxy server
• http://bsbioinfo/galaxy/
Create an account in the Galaxy server by going to User/Register in the top
menu. Use your U. Essex student email account, and set a password of your
choice and a public name. Please note that if you use different Galaxy server
you will need different accounts for each server.
Before to start, familiarize yourself with Galaxy. Open our local Galaxy
server in a web browser. Galaxy has three main windows (Figure 2.1). On
the left you will see the tools window from which you will be able to upload
files and run analyses. On the right you will find a history tab. In it, all your
analyses will be recorded, and all files generated during the process will be
listed. It is important that you keep record of these files so you know what
are they at any time. The window in the center is the main window, and it
will show the parameters and options of the programs you want to run, as
well as the output files.

Task 2a: Measuring transcript levels with RNA-seq
• Go to Galaxy and log-in with your account details.
• First you need to pre-load the genes for which you want to measure the
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expression level. Go to Get data->Upload File in the left panel.
• In the File Format field select ’fasta’, and select the fasta file with gene
sequences1 with the ’Browse...’ button. Press ’Execute’.
• On the left panel click on ’Get Data’ and find the ’EBI SRA’. That will
lead you to ENA, the European Nucleotide Archive.
• In the search field type ’ERX014110’. This is the accession number to
the dataset we are interested in.
• Click on ’Search’.
• You will find some useful information about how the expression information was obtained. Write down the number of reads produced in
this sequencing reaction.
• In a table at the bottom you will see the ’Submitted files (Galaxy)’
column, click on the ’Fastq file 1’ link below.
• After a while you will have a whole RNA-seq experiment loaded into
your Galaxy account.2
• Click on the ’pencil’ icon next to the uploaded file, and in the ’Datatype’
tab change the data type to ’fastqsanger’.3
• We want to map RNA read into our annotated genes. To do so we will
use the program Bowtie installed in Galaxy. In the ’Search tools’ field
in the left panel type ’bowtie2’ and click on the program.
• Select the fastq file you extracted from the database.
• In the ’Will you select a reference...’ tab select ’Use one from history’
and select the gene one.
• Click on ’Execute’. Your RNA reads will be mapped to the annotated
genes.
1

You downloaded this file from the BASys annotation page
The fastq format is like the one you saw in the previous practical, but this time each
sequence is a fragment of an RNA expressed in the cell.
3
Some programs in Galaxy do not recognize fastq files unless they are defined as
fastqsanger formatted files.
2
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At the end of this process a bam file will be generated. A bam file stores
the information of where the expressed sequence reads are mapped. In other
words, how much transcript is each gene producing. This program takes a
while, so for your convenience you will find the result file as well as other bam
files stored in the Galaxy server. In the next step you will be comparing the
expression profiles of the two samples of Campylobacter.

Task 2b: Comparing multiple samples
• In Galaxy go to the ’Shared Data->Data libraries’ from the top menu.
Select the ’campylobacter expression’ folder.
• Select all four datasets (samples) and click on ’Go’ to import to your
current Galaxy history.
• Click in the ’Galaxy’ icon (top-left) to return to the main window.
• In the ’search tool’ field type ’BAM’. Click on the ’SAM/BAM To
Counts’ link. This program allows you to convert the (not particularly
informative) BAM format into a table of read counts.
• In the ’Short names for samples’ box type ”sample 1,sample 2,sample 3,sample 4”
• Select ’BAM’ format in the box below.
• Now, select ’sample 1’ as a BAM file, click on ’Add new Additional
BAM file’. Select ’sample 2’, and so for until you have all four samples.
• ’Execute’
• When the process is done you will have a table with counts in your
history tab. Click on the ’eye’ icon and you will see the read counts
per each gene in each of the four samples.4

Well done, you can now visualize how the genes you annotated are expressed
from four different samples. Actually, samples 1 and 2 come from one laboratory, and samples 3 and 4 come from another. You suspect that expression levels may be different between these two laboratories as they may
have analyzed different bacteria strains. To determine whether there are
4

Remember for the lectures, the read count is the number of RNA molecules sequenced
from the sample, and it’s a measure of the expression level of the gene.
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differences in gene expression, you know will do the (probably) most common Genomics/Bioinformatics type of analysis: differential gene expression.
More specifically, you’re about to detect which genes are higher expressed in
samples from laboratory A with respect to samples from laboratory B.

Task 2c: Differential gene expression
• Find the ’De Seq’ tool in Galaxy and open it.
• Select the counts file you just generated and in the ’Column Types in
counts file’ field type ”labA,labA,labB,labB”. That will indicate that
the first two samples came from laboratory A and the other two from
laboratory B.
• In ’Comparison type’ write ”labA,labB”, which tells the program that
you want to compare samples from labA with samples from labB.
• ’Execute’
• After a while two files will be generated. One of them, the ’Top Table’
will list those genes for which the expression was different between the
two datatsets.
• Click on the ’eye’ icon next to the ’Top Table’ file. ’Fold change’ column
is the expression level of sample A divided by the expression level of
sample B. ’Padj’ is the p-value adjusted for multiple testing.
• Genes overexpressed in labA samples will have a fold change greater
than 2 (this is an arbitrary threshold). Also, we are interested in those
with a significant change, which we now define as having a adjusted
p-value below 0.01. Galaxy can help us to parse this list of genes.
• Find the ’Filter’ tool and run it over the ’Top Table’ output file. The
condition to filter is ”c5>2 and c8<0.01”.5 ’Execute’.
• Since you’re only interested in the list of genes, find the ’cut’ tool and
in the ’cut columns’ field type ”c1”.
• ’Execute’ and open (’eye’ icon) the resulting output file. This is the
list of genes overexpressed in lab A samples.
5

That means, genes with a fold change (column 5) greater than 2, and a adjusted
p-value (column 8) lower than 0.01.
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• Keep this window open as you will be analyzing some of this information in the next task.

Questions to be addressed in the final report
• How many reads did the RNAseq experiment produce?
• Find examples of highly expressed genes and lowly or no expressed
genes.
• How many genes are upregulated in laboratory A samples?

2.3

Functional annotation of gene lists

To know the function of a gene is relatively easy. To understand the function
of hundreds of genes at the same time, is not that easy. As we discuss in
a lecture, there is a way of finding Gene Ontology annotation terms who
are enriched for a particular list of genes. Next, you’re about to find which
functions are upregulated (genes are overexpressed) in the samples comming
from laboratory A.

Task 3: Gene Ontology enrichment analysis
• Open a new web-browser window and go to http://geneontology.
org/page/go-enrichment-analysis
• This tool allows you to quickly evaluate GO term enrichements. Paste
in the ’Enrichment analysis’ window the list of genes from the previous
Task.
• Select ’Biological Process’ and the species ’E. coli’.6
• ’Submit’
• Explore the results.
6

We select E. coli because the gene names given during the annotation process were
taken from this species.
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Questions to be addressed in the final report
• Which GO term is the most significantly enriched?
• By looking at the top enriched GO term, can you conclude which
metabolic process is different between the two samples?
Other databases and resources
In this tutorial you explored some databases such as ENA and Gene Ontology. However, there are many other that you may find useful in your future
genomic investigations. Here are some of them:

• GeneBank: Genes and genome sequences. (http://www.ncbi.nlm.nih.
gov/genbank)
• GEO: Gene expression data. (http://www.ncbi.nlm.nih.gov/geo)
• OMIM: Genes involved in Mendelian (monogenic) diseases. (http://www.
ncbi.nlm.nih.gov/omim)
• GeneCards: Extensive information on human genes (http://www.
genecards.org/)
• Xfam: This site directs you to Pfam, Rfam, Dfam... which are databases
specific for proteins (Pfam), RNA (Rfam)...(http://xfam.org/)
• BioGRID:
BioGRID)

Interaction

networks

(http://en.wikipedia.org/wiki/

• RepBase: Database of transposable elements (http://www.girinst.org/
repbase/)

2.4

Further reading

The tools you used are standard in bacterial genome annotation. For eukaryotic genomes, the same principles apply, but the programs are more
sofisticated as they have to account for introns, alternative splicing, and
more complex gene structures in general. You will find more information on
Bacterial genome annotation in the following review paper:
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• Richardson EJ and Watson M (2012) The automatic annotation of
bacterial genomes. Brief Bioinformatics 14:1-12.

A superb introduction to Eukaryotic genome annotation can be found in:
• Yandell M and Ence D (2012) A beginner’s guide to eukaryotic genome
annotation. Nature Review Genetics 13:329.

Practical 3
Re-Sequencing Genomes
You’ve learnt so far how to assemble and annotate a whole genome from
scratch. That’s a very useful skill but, why stop there? Sequencing is getting
cheaper and cheaper and now it is possible to compare the genome sequence
of multiple individuals at a time. After all, biology is about populations and
diversity, and that’s the last thing we will explore in this series of practicals:
genome diversity.

3.1

Comparing genome sequences

It all started with a few contaminated apricots, now you know that a pathogenic
strain of Campylobacter jejuni was behind the outbreak. You know the
genome sequence, its gene content, and you even analyzed its expression
profile. But how does this genome compare to other evolutionary related
genomes? How similar is to Campylobacter coli which you used to assemble
the contigs into scaffolds in the first practical?
The best way to answer this question is by whole-genome alignment. You
will remember from the first part of this module that short DNA sequences
can be aligned using standard algorithms. Now, you’re gonna use similar
strategies to align whole genome sequences. You already know the software,
Mauve, but you will use it to compare multiple fully assembly genomes. To do
so, you will align the genomes of your query Campylobacter jejuni genome,
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another C. jejuni strain, and other related species: C. coli and C. fetus.

Task 1: Align genomes with MAUVE
1. Uncompress the campylo.zip file provided.
2. Open the Mauve program and go to ’File->Align with progressiveMauve’.
3. With ’Add Sequence’ open the files for the four Campylobacter genomes
provided.
4. Click on ’Align’.
5. The program will ask for an output file name. Pick any name you like
(such as ’campylo align’), and press Enter.
6. The program will take a few minutes to align the four genomes.1
7. When the process is done, you will see a window showing a four way
alignment (Figure 3.1). Each color box is a conserved block, connected
with lines accross the genomes.
8. You can hide selected genomes by cliking on the ’-’ on top of the red
’R’.
9. Play around with the alignments and discuss with your mates.

Questions to be addressed in the final report
• Which genome is more similar to your query genome and which one is
more distant?
• Discuss in your report what you see in the alignment. You can include
a figure of the alignment (’Tools->Expore->Export Image’).
1

Mauve uses a ’greedy approach’ for sequence alignment, as we briefly discussed in the
main lecture.

3.2. RE-SEQUENCING GENOMES

23

Figure 3.1: Mauve genome alignment program

3.2

Re-sequencing genomes

Epidemiological research in the outbreak due to contaminated apricots determined that a new strain of C. jejuni is particularly dangerous: it is lethal
in most infected patiens! Most likely, this strain is likely the result of one or
a few recent mutations. You just got a sample from this particularly dangerous bacteria and got it sequenced. Now, you’re about to scan it for point
mutations, that is, single nucleotide polymorphisms (SNP)2 between the two
samples. This is a common technique used in the analysis of population, and
it is known as SNP-calling.
As in the previous practical, you will use our Galaxy server. Remember you
can use any of these two addresses:

• http://bsproteomics/galaxy/
• http://bsbioinfo/galaxy/

Task 2a: SNP calling with Freebayes
• Go to Galaxy (see previous practical handbook for details) and log-in
with your account.
2

pronounced snips
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• Upload the fastq or fastqsanger file provided. That contains sequence reads from the mutant lethal strain.
• Upload the C. jejuni query genome as a fasta file.
• Open the Bowtie2 program.
• Select the fastq file you just uploaded.
• Change ’Use a built-in index’ to ’Use one from history’ and select the
genome you uploaded.
• ’Execute’. Now your reads are going to be mapped to the reference
genome you provided. The output file will be, as in the first of these
practicals, a ’bam’ file.
• Open the Freebayes program. Actually, in our Galaxy server it is
called ’Call SNPs with Freebayes’.
• ’Reference file’ should be the uploaded genome, ’Bam alignment file’ is
the output of Bowtie2. ’Execute’ !3
• Open the output file (’eye’ icon) and you will see some comment lines
to be ignored (beginning with ’##’) followed by the SNPs detected
between the reference genome and our mutant strain.
• To sort out the SNPs detected by quality (QUAL) we open the program
’Sort’ in Galaxy and select the output file from Freebayes. Then we
sort numerically in descending order using column 6.
• The first two entries in the sorted table have a high quality. Choose
the one with the lowest ’AB’ value.4
• Write down the position of the detected SNP as you will be using this
information in the next task.

Up to this point you have characterize the most likely point mutation that
occurred in the mutant bacteria strain. Actually, many more mutations,
3

Every time you see the word ’bayes’ or ’bayesian’ in a program means that the program
use sophisticated probabilistic models. It other words, it’s going to be slow. Be patience,
the output of Freebayes can take a few minutes.
4
’AB’ value is in the INFO column. ’AB’ is a number between 0 and 1, which is the
ration of the reference allele with respect to the alternative allele. The lowest the value,
the more likely there’s a SNP in this position.
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including insertions and deletions have happened, but for simplicity we will
focus solely in the most significant of the changes. Now, we should know
were this mutation is in the genome. Let’s have a look at a genome browser
and find out.

Task 2b: Mapping a mutation with a genome browser
• In a web browser go to http://archaea.ucsc.edu/cgi-bin/hgGateway?
db=campJeju
• This is a Genome Browser of C. jejuni, that is, a graphical display of
a genome sequence we can navigate. In the ’position or search term’
field type ’chr:’ followed by the position of the SNP you detected. For
instance, ’chr:123456’.5
• The browser will display only one nucleotide, which is where the mutation happened. Zoom out until you see the name of the gene where
the SNP has been found. At this stage you may need to play around
the browser and familiarize yourself with the information it contains.
• Click on the gene name (something like ’Cj’ followed by a number).
• In this page you will find some useful about the affected gene.

Questions to be addressed in the final report
• What are the values of the top two detected SNPs?
• What is the ’AB’ value of the selected SNP, and what it means.
• For this SNP, what is the reference genome allele and what is the allele
in the mutant strain?
• Which gene is affected by this mutation?
• Why do you think this mutation may have produced a more dangerous
bacteria?6
5

In a Genome Browser you have to write the chromosome number, for instance, chr1
or chr 21. Since C. jejuni has only one chromosome, you write only ’chr’.
6
There’s no correct answer here, but this is a great opportunity for you to speculate
based on the predicted function of the gene.
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Well done! You’ve successfully analyzed the genome of the new pathogenic
strain. Thanks to your efforts (and those of your colleagues) applied pharmacologists are now working in a new medication and epidemiologists know how
to quickly detect the bacteria. The World needs scientists like you to fight
against disease. Have you consider a career in the exciting field of genomics?

3.3

Genome-Wide Association Studies

This part of the practical is here only for completeness and should not be covered in the SPF. The goal is that you become familiar with GWAS7 datasets
and how to navigate them.
In the lecture we discussed how Genome-Wide Association Studies (GWAS)
can help us to identify genes associated to diseases. Here we will explore a
Manhattan plot to identify loci associated to Rheumatoid Arthritis. We will
use the Integrated Genome Viewer (IGV), a Java application developed by
the Broad Institute.

Task ∞: Browsing GWAS experiments with IGV
• Download the gwas file provided (via Moodle) and unzip it.
• Go to http://www.broadinstitute.org/igv/ and register as a user
to download the IGV
• Launch the application with 750 MB, do not update the Java version
of your computer and ignore all warning messages.
• After a short while you will have a window open. Go to the top left
corner click on the ’Human hg18’. This is not the version our data was
mapped to. Select ’More...’ and find version hg19. Upload it.
• Click on File->Load from file, and select your GWAS dataset.
• You will see a Manhattan plot which covers all human chromosomes.
Without further instructions, explore it and try to identify which gene/s
were associated to Rheumatoid Arthritis in this particular dataset.
7

pronounced gee-was
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Further reading

Details on SNP calling and software can be found in:
• Nielsen R et al (2011) Genotype and SNP calling from next-generation
sequencing data Nat Rev Genet 12:443-451.
An affordable review on GWAS is:
• Bush WS and Moore JH (2012) Genome-Wide Association Studies .
PLoS Comput Biol 8:e1002822.

